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Titulo del resumen

RESUMEN

En este proyecto se ha buscado conocer la capacidad que tiene el dispositivo
comercial Emotiv Epoc+ a la hora de detectar picos en la actividad encefalogréfica
debidos a estimulos cognitivos, también conocidos como potenciales evocados
cognitivos, utilizando para ello Matlab.

Para ello, se ha realizado una revision sobre el cerebro humano, analizando las
funciones que tienen cada area del cerebro, el tipo de onda que se generan en cada una
de ellas y su significado.

Se ha estudiado el funcionamiento de Emotiv Epoc+, asi como de sus softwares y
como puede ser utilizado Matlab para procesar las senales obtenidas previamente con
Emotiv Epoc+.

Para procesar las senales, se ha utilizado la libreria de EEGlab, debido a su fécil
manejo y a que estd creada para procesar senales electroencefalograficas.

Se ha dado una visién general del estado del arte de este tipo de tecnologias y se
han explicando las principales aplicaciones en las cuales se estan usando este tipo de
dispositivos.

Para las pruebas, se ha utilizado el paradigma del ente extrano. Esta prueba consiste
en usar dos tipos de estimulos, uno frecuente y otro infrecuente. El estimulo infrecuente
provoca la aparicién de los potenciales cognitivos.

Para localizar los potenciales evocados cognitivos, se han utilizado clusters y
comparacion por medio del coeficiente de correlacion de Pearson. Para ello se precisa de
una libreria de plantillas de potenciales evocados que pueda ser usado para la deteccién
de nuevos potenciales evocados.

En este proyecto se han realizado tres tipos de pruebas. Habiéndose realizado un
total de 90 sesiones.

Se ha podido concluir que, aun siendo capaces de detectar cierto ntimero de
potenciales evocados, su fiabilidad no es total y por tanto, no debe utilizarse este

método como prueba concluyente en un juicio.
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Capitulo 1

Introduccién y objetivos

1.1. Objetivos y alcance del proyecto

El objetivo principal de este trabajo es identificar la capacidad de detectar
potenciales evocados de caracter cognitivo, y la busqueda de futuras aplicaciones. Para

ello, se necesita tener ciertas habilidades y conocimientos:

— Funcionamiento de las ondas cerebrales, origen de los distintos tipos de ondas y

el motivo que las genera.
— Saber como utilizar Emotiv Epoc+

— Ser capaz de detectar por medio de Emotiv Epoc+ y Matlab los potenciales
evocados P300

En este proyecto se pretende conocer los distintos tipos de ondas cerebrales, conocer
la funcion de cada area del cerebro e interpretar el significado de las ondas.

Emotiv Epoc+ es un dispositivo capaz de hacer electroencefalogramas. Su
adquisicién estd al alcance de todos, por 799%. Se puede comprar en la pagina web
de Emotiv.

Los potenciales evocados son fluctuaciones del electroencefalograma que son
producidas por estimulos sensoriales, motores, o cognitivos.[1][2][3][4]. A partir de
este proyecto, se pretende poder desarrollar nuevos programas capaces de detectar

potenciales evocados en tiempo real.

1.2. Introduccion biolégica

El sistema nervioso central de la persona es la estructura biolégica compuesta por
el encéfalo, el cerebro y la médula espinal. Es el sistema que procesa los estimulos y
genera una respuesta acorde a ellos. El cerebro humano constituye el 2 % del peso total

del cuerpo y consume 1/6 del gasto cardiaco. No hay diferencias entre sexos.|[5][6]
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El cerebro humano esté constituido por dos hemisferios. Cada uno de los hemisferios
tiene unas funciones distintas.[5][6]

Entre otras funciones que desarrollan, el hemisferio izquierdo es el que controla las
funciones motoras de la parte derecha del cuerpo y el hemisferio derecho es el hemisferio
que controla las funcionas motoras de la parte izquierda. El hemisferio izquierdo es
capaz de reconocer palabras, frases, etc, etc. Es el hemisferio encargado de procesar la
comunicacion y la légica. El hemisferio derecho también procesa informacion de forma

visual y espacial, no verbalmente.[7][5][6]

Lobulo parietal

Lobulo frontal

Lobulo temporal
FADAM.
Figura 1.1: Regiones del cerebrol[8]

Cada hemisferio se divide en regiones, conocidos como l6bulos, dependiendo de su
posicion y estas a su vez se dividen en areas. En estas regiones, Brodmann identifico
areas, segun sus funciones. Estas areas son conocidas como &areas de Brodmann. La

figura(1.1) muestra la localizacién de cada 16bulo.[7][5][6]

— Los 16bulos frontales: Desde el punto de vista funcional, son la parte encargada
de la planificacién, regulacion y control de procesos psicolégicos. Son las regiones
encargada de coordinar las diversas opciones de la conducta humana, organiza la

conducta, en funcién de metas, motivaciones, etc, etc.[9][10][6]

— Los l6bulos parietales: Su funcién principal es el procesamiento y la integracién
de la informacién sensorial y visual, relacionada principalmente con el control del

movimiento.[11][10][6]

— En la frontera entre los l6bulos parietales y frontales, se encuentra el area

encargada del movimiento de las distintas partes del cuerpo y de los sensores que



se encuentran en él. Es el drea donde se encuentran los hominculos.[11][10][6]

— Los lobulos occipitales: Su funcién principal es la recepcién de los estimulos
visuales. Esta area estda conectada mediante nervios con los dos ojos. El 16bulo
occipital izquierdo con el ojo derecho y viceversa. Parte del lobulo occipital se

encarga de la interpretacion de los estimulos visuales.[10][6]

— Los l6bulos temporales: No poseen una funciéon tnica. Se pueden distinguir
cuatro grandes areas cuyas funciones son, auditiva primaria, auditiva secundaria,
reconocimiento de objetos visuales y almacenamiento de informacion a largo

plazo, la memoria.[10][6]

A partir de diferencias de espesor en las capas corticales, el neuroanatomista
Korbinian Brodmann, desarrollé un nuevo mapa del cerebro. Cada una de las areas
especializada en una sola funcién. Como se puede ver en la figura(1.2) que muestra las

distintas areas, con sus principales funciones.

AREAS DE BRODMANN

[ Funciones ejecutivas

1 Funciones motoras

1 Somatosensorial

3 Atencion

1 Funciones visuales

1 Memoria

Regulacion emocional

3 Sonido
Fonoquqiolosos.wordpress.com

Figura 1.2: Areas de Brodmann[12]

En los electroencefalogramas es importante localizar correctamente los sensores con

respecto a las areas de Brodmann. La posicion del sensor, determina que senal se esta
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recibiendo.[6]

Funcidn Lobulo

Vision:

* Primaria 17

* Secundaria 18, 19,20, 21, 37
Audicion:

* Primaria 41

* Secundaria 22,42
Somestesia

* Primaria 1,2,3

* Secundaria 5,7
Sensorial terciaria 7.,22,37,3940
Motora:

* Primaria 4

e Secundaria 6

* Movimiento de los ojos 8

+ Habla

44

Maotora terciaria

9,10,11,45,46,47

Las neuronas son las células principales del sistema nervioso, figura(1.4). Su funcién
principal es responder ante estimulos. La forma que tienen las neuronas de comunicarse

entre si, es a través de estimulos nerviosos. Estos estimulos pueden ir dirigidos a otras

Figura 1.3: Funciones de las areas de Brodmann

neuronas a musculos o a glandulas.[13]

Nuestro cerebro esta formado por alrededor de 100.000.000.000 neuronas. Pudiendo

conectarse cada una de ellas con alrededor de 10.000 neuronas préximas o muy

lejanas.|[13]

Figura 1.4: Neurona[l14]




Las neuronas son capaces de recibir, codificar, y enviarse informacion entre ellas.
Esta comunicacion se realiza via eléctrica. Cada neurona tiene una carga de unos
70 micro-voltios, en reposo. Pero el cerebro esta activo en todo momento. Segun las
conexiones de cada neurona, y del estimulo recibido, el potencial de cada neurona varia.
Cada neurona se carga y descarga en funcién del estimulo recibido. A este hecho se le
denomina potencial de accion.[13]

El cerebro genera distintos tipos de ondas, cada una de ellas se caracteriza por un

rango de frecuencia y por tener unas caracteristicas asociadas a ellas. Estas son:

— Ondas Delta, son las ondas cuyo rango de frecuencia esta entre 0.1 y 4 Hz. Estas
ondas se asocian a la mente inconsciente. Aparecen en momentos de meditacion

o sueno profundo.[6]

— Ondas Theta, son las ondas cuyo rango de frecuencias esta entre 4 y 8 Hz. Estas

ondas aparecen durante la meditacién y el sueno ligero.|6]

— Ondas Alfa, son las ondas cuyo rango de frecuencia esta entre 8 y 14 Hz. Aparecen
cuando el individuo se encuentra despierto, pero con poca actividad cerebral y
con los ojos cerrados. También aparecen en la zona occipital cuando el sujeto es

sometido a flashes de luz a frecuencias no muy altas.[6]

— Ondas Beta, son las ondas cuyo rango de frecuencias se encuentra entre 14 y 30

Hz. Estas ondas aparecen cuando el sujeto se encuentra prestando atencion. [6]

La figura(1.5) muestra la forma que tienen dichas ondas.

Hay dos tipos de potenciales evocados a destacar, P300 y N400.

El P300 se caracteriza por ser positivo y de gran amplitud. Cuando se trata de
potenciales evocados de caracter cognitivo, aparecen tras ver, oir o entender un hecho
que se esta buscando, o es discordante con el resto. Por ejemplo, si en una serie de
objetos iguales, si aparece otro distinto, el P300 aparecerd. Se origina en la posicién Pz
del sistema 10-20, este sistema se explica en la seccién(1.3) .[1][2][3][4]

El nombre de P300 se debe a que aparece alrededor de 300ms después del estimulo
que lo evoca, y a que es una deflexién positiva. [2][3][4][16]

E1 N400, aparece con una latencia de 400ms, con respecto al estimulo, y es de carga
negativa. Este potencial aparece cuando el estimulo que se esta viendo, escuchando o
leyendo, no tiene sentido. Por ejemplo seria el caso de “Por el mar corren las liebres.”,
al considerar el cerebro que la oracién es incorrecta, o ilégica, aparece el N400.[1] El
ejemplo de oracion incoherente ha sido sacada de la cancién infantil ”Vamos a contar

mentiras”.



M A S T

Eyes open Eves closed

Figura 1.5: Ondas cerebrales[15]

1.3. Electroencefalograma

La electroencefalografia es el registro y evaluacion de los potenciales eléctricos,
generados en el cerebro. Se obtiene por medios no invasivos, como son los electrodos
colocados sobre el cuero cabelludo.[2]

Gracias a la obtencién de las senales eléctricas generadas en el cerebro a través de
estos electrodos, se puede entender mejor el funcionamiento del mismo.|[2]

Los primeros electroencefalogramas realizados en 1920, fueron desarrollados por el
doctor Hans Berger. Esta nueva técnica de estudio del cerebro fue un gran avance para
la neurociencia y la psiquiatria.[17]

Los electroencefalogramas se utilizan para detectar traumas craneales, tumores,
evaluar problemas durante el sueno y otros.[18]

La obtencion de resultados anormales en los electroencefalogramas puede ser
producido por problemas cerebrales, como traumatismos o edemas. También pueden
ser debido a la ingesta de drogas, estimulantes u otro tipo de productos que alteren las
capacidades cognitivas del sujeto.[18]

El sistema 10-20 es el sistema internacional que se utiliza a la hora de colocar los
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sensores en los electroencefalogramas. Cada posicion esta descrita por una letra y un
nimero. Las letras son F, T, C, P y O. Los ntiimeros pares se corresponden al hemisferio

derecho del cerebro y los impares al hemisferio izquierdo.[19]

1.4. Herramientas utilizadas

En el desarrollo de este proyecto, se han utilizado distintas herramientas. Dichas
herramientas son:

Emotiv epoc, dispositivo que realiza electroencefalogramas.

Matlab, es el software matematico usado para realizar el proyecto.

EEGIlab, es una libreria de Matlab para trabajar con senales electroencefalograficas.

EMOTIVXAVIERPURE.EEG, programa de Emotiv especializado en la grabacion
de electroencefalogramas.

A continuacion se explican las herramientas en mas detalle:
— Emotiv Epoc+:

Emotiv Epoc+ es un dispositivo de caracter comercial capaz de realizar
electroencefalogramas. Cuenta con 14 sensores para ser distribuidos por el créaneo. La
localizacién de los sensores se puede ver en la figura(1.7) y figura(1.8).[20]

Este dispositivo se compone de distintas partes, por un lado, el casco, en el que esta
toda la electronica capaz de adquirir, procesar y enviar los datos por medio de bluetooth
al ordenador.[21][20] Y por otro lado los sensores, son 16 pequenas almohadillas con
una fina capa de oro en el extremo por donde se conectan al casco. Estas almohadillas
deben ser hidratadas con una solucién salina para mejorar la conductividad.[20]

Por 1ltimo, el dispositivo incluye un cargador para el casco. La bateria tiene una
duracién media de unas 12 horas.[20]

En la figura(1.6), se pueden ver los distintos componentes de Emotiv Epoc+-.[20]

En la figura(1.7) se muestra la forma correcta de colocacion del casco.[20]

En la figura(1.8) se ve la posicién de los sensores, con respecto al sistema 10-20.[20]



Figura 1.7: Colocacién de Emotiv[20]

Figura 1.8: Colocacién de Emotiv con respecto al sistema 10-20[20]

— Matlab:

Matlab es un software matematico que ofrece un entorno de desarrollo integrado, con
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un lenguaje propio. Entre sus funciones se encuentra la manipulacién de matrices.[22]
— EEGlab:

EEGIlab es una libreria de Matlab, distribuida bajo licencia de GNU y GPL y gratuita.
EEGlab esta preparada para el procesamiento de datos electroencefalégraficos,
magnetoencefalograficos y electrofisiologicos.

Dentro de EEGlab hay librerias capaces de eliminar fenémenos extranos, como
pueden ser para nuestro trabajo el ruido generado por el movimiento muscular, o por

el pestaneo.[23] En la figura(1.9) se muestra el ment principal de EEGlab.

File Edit Tools Plot 5Study ERPLAB ERPsets Datasets Help Automagic k]

— No current dataset

— Create a new or load an existing datasetc:
Use "File > Import data™ (new)
Or "File > Load existing dataset™ (old)

— If new,
"File > Import epoch info™ (data epochs) else
"File > Import event info" (continuous data)
"Edit > Dataset info" (add/edit dataset info)
"File > Save dataset™ (sawve dataset)

— Prune data: "Edit > Select data™

— Reject data: "Tools > Reject continuous data™

— Epoch data: ™"Taools > Extract epochs™

— Remove baseline: "Tools > Remove baseline™

— Bun ICA: "Tools > Run ICA™

Figura 1.9: Menu principal de EEGlab|[23]

— EMOTIVXAVIERPURE.EEG:

EMOTIVXAVIERPURE.EEG es el software de Emotiv para la grabaciéon de las
seniales electroencefalograficas. En la figura(1.10) se pueden ver las catorce senales
correspondientes a las senales obtenidas desde los catorce sensores. En la parte superior
a la izquierda, se identifica si los sensores estdn correctamente colocados, la luz verde
significa que el contacto entre el sensor y el cuero cabelludo es correcto, el naranja
significa que el sensor hace contacto, pero este es deficiente y el color rojo significa que
no hay contacto, o es incorrecto.[20]

Para grabar una prueba, hay que seleccionar la funcién “Record”, en la parte inferior
a la izquierda.

Emotiv vende licencias mensuales para poder utilizar este software. Hay distintos

tipos, 50 grabaciones mensuales, 75 mensuales o 100.[20]
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Capitulo 2

Estado del arte

En los ultimos anos, con la apariciéon de electroencefalogramas de uso comercial,
como el dispositivo Emotiv Epoc, se han realizado distintas investigaciones sobre el
alcance que puede llegar a tener el uso de estos dispositivos en el dia a dia de las
personas.

Un ejemplo de investigacion en este ambito fue el desarrollado por las universidades
de Oxford, Génova y la UC Berkeley. Su investigacién se realizo con el dispositivo
Emotiv Epoc, buscando averiguar la seguridad que tienen los usuarios de este tipo de
dispositivos ante posibles intentos de robo de informacién personal, como puede ser el
caso del robo del pin de la tarjeta de crédito.[24]

Los potenciales evocados también han sido foco de interés para su utilizacion
en investigaciones policiales. Estas investigaciones se han basado en los potenciales
evocados cognitivos. Con este sistema se pretende poder distinguir entre un dato
irrelevante para el individuo, de un dato que sea relevante.[1] [25]

No solo se utilizan los potenciales evocados cognitivos, también es frecuente la
utilizacién de potenciales evocados visuales. Este sistema es més sencillo de utilizar. Los
sistemas que aprovechan las respuestas cerebrales ante estimulos visuales, se basan en
la sincronizacién entre estimulos (destellos de luz) a distintas frecuencias y la aparicién
de picos de gran amplitud a distintas frecuencias de onda. Esta prueba ha sido utilizada
para detectar tipos de ceguera. De esta forma es posible detectar si el problema esta
en los 0jos o es un problema de cardcter cerebral.[26]

La utilizacién de senales electroencefalograficas para el uso domestico se esta
empezando a desarrollar. Hay proyectos que pretenden mejorar la vida de las personas
que sufren discapacidades fisicas.

Gracias a estos dispositivos, se puede lograr captar ciertas ordenes desde el cerebro
y poder utilizarlos como mandos.

El interés por las ondas cerebrales, y en especial por los potenciales evocados, ha

hecho que haya un gran nimero de proyectos que estan relacionados con la obtencién
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de estas ondas.[27]

El dispositivo Emotiv Epoc, aparte del uso de potenciales evocados, nos ofrece otras
posibilidades. Gran parte de las aplicaciones que nos ofrece estan dirigidas a potenciar
las capacidades del usuario. Es el caso de uno de los softwares que permite mover
mentalmente un cubo que se encuentra en el ordenador.[20] Con base en este software,
se ha desarrollado un programa capaz de hacer mover un drone a partir de las ordenes
emitidas desde el cerebro.[20]

Para lograr un buen funcionamiento de este programa, se necesita un gran
entrenamiento. Por ejemplo, en el caso del software para mover un drone, los
movimientos han de ser asociados a un tipo de senal. El software no es capaz de
detectar el pensamiento derecha, o izquierda.|20]

Una de las aplicaciones mas interesantes, dentro de este campo, es la utilizacién de
los potenciales evocados para ayudar a las personas que tienen grandes discapacidades
a poder comunicarse.

Otra de las pruebas que se esta desarrollando en estos anos consiste en el paradigma
del ente extrano. La misma que se esta utilizando en este proyecto.

A partir de este paradigma se esta desarrollando una prueba denominada ”Speller”.
Esta prueba consiste en identificar las palabras que esta pensando un sujeto por medio
de la deteccion de las letras que forman una palabra, una frase, etc. Para detectar las
distintas letras, se muestran en pantalla todo el alfabeto, pero de letra en letra, de
esta manera se asocia el momento en el que aparece el potencial evocado, con la letra
deseada.[28][29][30][31]

En el uso de ondas electroencefalograficas para la mejora de la vida de las personas
con discapacidades destaca el uso en sillas de ruedas. Este mecanismo permite a las
personas con discapacidades motoras ser capaces de manejar una silla de ruedas por
medio de dispositivos como Emotiv Epoc.[32]

Pero se pretende llegar mas lejos aun, se estan haciendo investigaciones en el campo
del "Motor Imagery”, que consiste en, por medio de ondas cerebrales, ser capaces de
mover extremidades roboticas.[33] Este seria el siguiente paso en el desarrollo de las
sillas de ruedas. Con el desarrollo de esta investigacion, se podria ayudar a todas

aquellas personas que han perdido extremidades, o han quedado paraliticos.
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Capitulo 3

Metodologia

3.1. Realizacion de las pruebas

Como ya se ha indicado, el objetivo de este proyecto es identificar como se pueden
detectar potenciales evocados desde el cerebro. Hay distintos tipos de pruebas, segin
la capacidad de los sujetos de mantener la concentracién. Para ello se ha usado el
paradigma de la rareza (Oddball paradigm).

Este paradigma consiste en la reaccién que tiene el cerebro frente a un estimulo
extrano. La prueba consiste en someter al sujeto de prueba a un estimulo frecuente y
a un estimulo extrano, el estimulo extrano significa, distinto al estimulo frecuente.
El estimulo extrano debe aparecer con mucha menos frecuencia que el estimulo
frecuente. La frecuencia del estimulo extrano influye en la captacion de los potenciales
evocados.|[1]]24][34][2][35][36]

En nuestro proyecto hemos realizado dos pruebas. El primero consiste en identificar
colores, donde hemos utilizado como estimulo extrano el color verde, figura(3.1) y como
estimulo frecuente el color morado, figura(3.2). La segunda prueba, mas compleja,
consiste en la seleccion de una carta de la baraja espafiola, figura(3.3), para localizar
en que momento el sujeto reconoce una determinada carta. En esta prueba pueden
aparecen factores de duda ante cartas muy parecidas, dando como origen a potenciales
evocados en momentos en los cuales no deberian aparecer.[37][16][38][35]

Para que el estimulo extrano, no se convierta en frecuente, se han utilizado formatos
del mismo tipo de prueba. Se han utilizado dos videos, con imégenes de colores, con
distinta distribucién.

Debido a la disposicion de los sensores del casco de Emotiv Epoc+, no se consigue
captar correctamente el potencial evocado cognitivo, que se origina en el parietal
central, en la posicién Pz, segin el sistema 10-20[4]. En nuestro caso, el sensor que
mejor capta la senal es el sensor P7. Por ello debemos asegurarnos que este sensor este

bien conectado y tenga un buen contacto con el cuero cabelludo, intentando evitar que

13



aparezcan fenémenos extranos ajenos a la prueba.[24]

Figura 3.1: Estimulo visual verde[39]

Figura 3.2: Estimulo visual morado[39]

—

Figura 3.3: As de copas, baraja espanola[40]

3.2. Programa

El programa que se ha desarrollado para este proyecto analiza y senales
electroencefalograficas y por medio de clusters y la comparacion de las distintas

ondas de la senal con plantillas de potenciales evocados, se obtiene como resultado
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los momentos en los cuales han aparecido potenciales evocados, durante la realizacién
de la prueba. En la subseccién(3.3.1) se explica que son las plantillas y como se definen.
Dispone de tres fases:
La primera fase sirve para incrementar el nuimero de plantillas de potenciales
evocados.
La segunda fase, detecta en que momentos aparecen potenciales evocados por medio
de clusters y comparacién con plantillas de potenciales evocados previamente definidas.
La tercera fase detecta potenciales evocados y permite extraer y guardar aquellos
que se ajustan a las plantillas definidas por el usuario.

En la figura(3.4) se puede ver el menu principal del programa.

Elija opcion:
1-Afiadir patrones de potenciales
Buscar potenciales evocados

dir patrones de potenciales

Cualguier otro numero significa cerrar el programa

Escriba el numero:

Figura 3.4: Ment del programa

— Fase 1:

La fase 1 tiene como funcién la definiciéon de nuevas plantillas de potenciales evocados.
Al comienzo del programa se pide al usuario que introduzca el nombre del archivo en el
que se encuentran los datos a procesar y el momento en el que ha habido un estimulo
extrano, un evocador.[25][34][37][38] La fase indicara el niumero de plantillas que se
tiene hasta el momento y la plantilla media. En la figura(3.5), se puede ver la forma

que tiene la media de los potenciales evocados.
— Fase 2:

La fase 2 es la funcién principal del programa, esto es la deteccién de potenciales
evocados en una muestra. Para detectar los potenciales evocados se precisan dos

archivos realizados con el mismo modelo de prueba.
— Fase 3:

La fase 3 es una combinacién de la fase 1 y 2. El objetivo de esta fase es detectar el
momento en el cual aparecen potenciales evocados en una muestra y tras ello, ser capaz

de extraer y guardar los potenciales evocados que se desee de los archivos utilizados.
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Plantilla de potencial evocado

Walor normalizado
—

0 100 200 300 400 500 600 700 OO SO0 1000
Duracion [ms]

Figura 3.5: Plantilla de potencial

3.3. Funcionamiento del programa

3.3.1. Fase 1l

Al comienzo del programa, se solicita al usuario que introduzca el nombre de un
archivo y los momentos en los cuales ha habido un evocador.

Los archivos que se analizan en este programa han sido obtenidos utilizando Emotiv
Epoc y almacenados en la carpeta ”Pruebas”. El funcionamiento de este dispositivo
se explica en la seccién(1.4). Es necesario que los dos archivos hayan sido realizado
utilizando la misma prueba.

Los modelos de pruebas con los que se trabaja han sido explicados en la seccién(3.1).

Como se senalo en la seccién(1.2), las ondas cerebrales tienen un rango de
frecuencias entre 0.5-30Hz y debido a que el dispositivo utilizado tiene una frecuencia
de muestreo de 128Hz, se debe utilizar un filtro paso alto paso bajo, entre
0.5-30Hz.[21][25][37][34][41][42] El filtrado se realizara utilizando la librerfa de Matlab
EEGIab, en la seccién(1.4) se han definido el software Matlab y la libreria EEGlab.

La senal ya filtrada, se somete a un tratamiento de andlisis de componentes
independientes (ICA).[23]

Para homogeneizar todas las muestras realizadas, independientemente del sujeto al
que se le ha realizado la prueba, el tipo de prueba o el momento en que se ha realizado,
se procede a normalizar la senial. Normalizar la senal consiste en obtener una senal cuya
media es 0V y su desviacién tipica es 1.[34][37][38][42] Para normalizar una senal se

calcula la media de los valores de la senal y se le resta esta constante a la senal, de este
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modo, obtenemos una senal cuya media es 0. Para obtener una desviacién tipica de
valor 1, se obtiene la desviacion de la senal sin haber sido normalizada y se divide entre
la desviacién tipica obtenida. D es esta manera se consigue una onda con desviacion
tipica 1.[42]

Los potenciales evocados cognitivos aparecen en la posicién Pz del sistema 10-20.
Dado que el dispositivo utilizado en este proyecto no posee sensor en la posiciéon Pz
citeemotiv, como se explica en la seccionl.4. El sensor que mejor capta los potenciales
evocados es el sensor P7.[21][24] Por ellos, solo se usara la senal obtenida con el sensor
P7 a la hora de obtener las plantillas de los potenciales evocados.

Para aceptar como valida una onda, el programa utiliza una serie de criterios.
El primer criterio es localizar los momentos en los que ha habido un evocador. Esta
informacion es introducida por el usuario a comienzo del programa. Para aceptar como
valida la onda que hay en ese momento, se procede a detectar el instante de mayor
amplitud.[1][24][37]

Debido a las caracteristicas de los potenciales evocados, la onda P300 aparece con
una latencia de 300 ms, se utiliza como unidad de momento el segundo.[1][24][37]

Para aceptar como valida esa onda, esta necesita tener una amplitud mayor a 3.Este
criterio se usa basandonos en la distribuciéon gaussiana, la probabilidad de encontrar
un valor mayor a tres veces la desviacién tipica més la media es del 0.03 %.[43] Se
utiliza este método selectivo debido a la definicion de P300 , fluctuacion positiva con
una amplitud mayor al del resto de ondas encefalograficas.[1][24][37] Se describe en més
detalle en la seccién(1.2).

Habiendo anadido las nuevas plantillas de potenciales evocados se realiza un calculo
de la media de todas ellas y su desviacién tipica. En la figura(3.5) se muestra la forma
de la plantilla media.

El programa muestra en pantalla el niimero de plantillas definidas hasta el momento.
De esta forma se puede comprobar si en la sesién se han anadido nuevas plantillas a la

libreria.

3.3.2. Fase 2

Al comienzo del programa, se solicita al usuario que introduzca el nombre de dos
archivos obtenidos con Emotiv Epoc+ y almacenados en la carpeta ”"Pruebas”. En la
seccién(1.4) se explica el funcionamiento del dispositivo.

Tras solicitar el nombre de los archivos que se van a analizar, se pide al usuario
que introduzca un tiempo de margen entre pruebas. En ocasiones, la sincronizacién
entre dos pruebas no es exacta debida a que se hacen de forma manual, ocasionando

pequenas diferencias de tiempo, por ello se da la posibilidad al usuario de indicarlo.
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El usuario debe introducir el coeficiente de correlacion de Pearson que se utilizara
como limite, a la hora de detectar potenciales evocados. El procedimiento se explicara
mas adelante. Con esta fase, el usuario es capaz de seleccionar la semejanza entre la
senal y las plantillas que se tienen.

El usuario debe introducir el niimero de clusters a utilizar. Se recomienda el uso de
3 clusters, como aconsejan Micah M. Murray, Denis Brunet y Christoph M. Michel en
el articulo [41]. No obstante, puede utilizarse cualquier otro nimero de clusters.

La lectura de las senales se realizara por medio de Matlab, utilizando la libreria
EEGlab. En la seccién(1.4) se define el software Matlab y la librerfa EEGlab.

Como se senalo en la seccién(1.2), las ondas cerebrales tienen un rango de
frecuencias entre 0.5-30 Hz y debido a que el dispositivo utilizado tiene una frecuencia
de muestreo de 128 Hz, se debe utilizar un filtro paso alto paso bajo, entre 0.5-30
Hz.[21][25][37][34][41][42] El filtrado se realizara utilizando la libreria de Matlab
EEGIab.

Las senal se someten a un tratamiento de analisis de componentes independientes
(ICA).[23]

Para homogeneizar todas las muestras realizadas, independientemente del sujeto al
que se le ha realizado la prueba, el tipo de prueba o el momento en que se ha realizado,
se procede a normalizar la senial. Normalizar la senal consiste en obtener una senal cuya
media es 0V y su desviacién tipica es 1.[34][37][38][42] Para normalizar una senal se
calcula la media de los valores de la senal y se le resta esta constante a la senal, de este
modo, obtenemos una senal cuya media es 0. Para obtener una desviacién tipica de
valor 1, se obtiene la desviacion de la senal sin haber sido normalizada y se divide entre
la desviacién tipica obtenida. D es esta manera se consigue una onda con desviacién
tipica 1.[42]

En el proceso de deteccién de potenciales evocados se utilizan clusters, los clusters
son definidos en el parrafo siguiente.[25][34][41] Para ello se utiliza la funcién de Matlab
kmeans.[22] Hay distintos modelos de separacién por clusters, la funciéon kmeans genera
k grupos de una muestra con n datos, el método que utiliza para agruparlos es la media
de los datos, agrupando aquellos datos cuya media esta mas cercana.[22][44]

El analisis cluster es una técnica dentro de la estadistica que tiene como objetivo
agrupar conjuntos de datos en grupos, estando en el mismo cluster aquellos datos cuya
similitud sea relevante.|[45]

Para poder usar clusters, el programa convierte la senal del sensor P7 en una matriz.
El método que se utiliza para ello es seleccionar en cada segundo el pico mas alto y
centrarlo. Cada momento tiene una duracién de un segundo. Se obtiene una matriz con

128 filas, debido a que la frecuencia de muestreo del dispositivo utilizado son 128 Hz y
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tantas columnas como segundos tiene la duracion de la prueba. Se ha utilizado la senal
obtenida con el sensor P7, debido a que es el sensor que mejor captura los potenciales
evocados. Los potenciales evocados aparecen en la posicion Pz con respecto al sistema
10-20.[20][21][24][46]

A la matriz obtenida a partir de la senal del sensor P7 se le anade una nueva
columna, esta columna tiene como datos la plantilla obtenida calculando la media
entre todas las plantillas definidas hasta ese momento en la fase 1.

En la realizacién de los clusters se utiliza la ya mencionada funcién kmeans. Se
obtiene como salida de la funcién un vector con tantas columnas como columnas tenia
la matriz anterior y con una tnica fila.

El primer paso en la localizacion de potenciales evocados consiste en la deteccion
de aquellos momentos que han sido agrupados en el mismo cluster que la plantilla
media de potencial evocado. El programa considera que estos momentos tienen unas
caracteristicas comunes con la plantilla utilizada y que por ello deben tenerse en cuenta.
El nimero de clusters utilizados determina la cantidad de momentos agrupados junto
a la plantilla utilizada. El uso de un numero grande de clusters puede causar que
los parametros utilizados para realizar los clusters no sean las caracteristicas de los
potenciales evocados.[41]]46][47]

Se procede a comparar utilizando la ecuacién de Pearson, ecuacién(3.1). Se
seleccionan los momentos que se encuentran en el mismo cluster que la plantilla de
potencial evocado medio. Estos momentos son comparados por medio de la ecuacién
del coeficiente de correlacion de Pearson con las plantillas previamente definidas en la
fase 1.[34][25][38][41][48] Un ejemplo de esta comparacién se muestra en la figura(3.10).

Para mejorar el funcionamiento y asegurarnos la semejanza con las plantillas de
potenciales evocados, se posee una libreria de ondas en las cuales no hay potenciales
evocados, con la cual también es comparada, seleccionando solo aquellos momentos en
los cuales, el coeficiente de correlacion entre la onda y la plantilla de potencial evocado

es mayor que la correlacién entre la onda y la plantilla de estado normal.

Coe ficientedePearson = Tay (3.1)
0.0y

Donde o, es la covarianza entre x e y, o, es la desviacion tipica de x y o, es la
desviacion tipica de y.

El ultimo paso en la deteccién de potenciales evocados es la comparacién del
coeficiente de correlacién de Pearson con el limite introducido a comienzo del programa.
Este limite selecciona solo aquellos valores mayores que ese limite. De este modo,

solo se seleccionaran aquellos momentos que se parezcan mé&s a las plantillas ya
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definidas.[34][25][38][42]

Todos los pasos definidos hasta el momento se realizan sobre las dos muestras. El
ultimo paso consiste en la comparacion de los resultados de ambas muestras.

Se realiza una comparacién de los dos resultados para eliminar aquellos momentos
en los cuales puede haber aparecido un potencial evocado ajeno a la prueba.

Es en este momento cuando se utiliza el tiempo de compensacién de la falta de
sincronizacién entre pruebas. El comienzo de la grabacion de la prueba se realiza de
forma manual, esto produce pequenos errores en el momento en el que comienza la
grabacion y el momento en el que comienza. Por ello, se ha intentado compensar este
error permitiendo al usuario introducir una el margen de tiempo en el cual se encuentra

dicho error. Con este paso se pretende afinar mas en la obtencién de resultados ttiles.

3.3.3. Fase 3

La fase 3 es una combinacién de las fases 1 y 2. El procedimiento que se sigue en
esta fase es el mismo que para la fase 2, se solicita al usuario que introduzca el nombre
de dos sesiones realizados con la misma prueba.

La primera parte del programa es idéntica a la fase 2. En la subseccion(3.3.2) se
describe todo el proceso.

Tras obtener la localizaciéon de los momentos en los cuales el programa considera
que hay potenciales evocados, se pide al usuario indicar en que momentos se desean
guardar como nuevas plantillas, como en la fase 1. En la subseccién(3.3.1) se describe

todo el proceso.

3.4. Lectura de resultados

Cada parte del programa tiene un tipo de resultado. La fase 1 tiene como resultado
la definicién de plantillas de potenciales evocados. La estructura se muestra en la
figura(3.6).

plantillas =

normal: [lxl struct]

potenciales: [1xl struct]

Figura 3.6: Visualizacion de la estructura de las plantillas.

Dentro del apartado normal, se encuentran las plantillas de muestras en las cuales

no aparecen potenciales evocados. Se muestra en la figura(3.7).
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.normal

muestras:
data:

media:

Figura 3.7: Visualizacion de la estructura de las plantillas normal.

En la figura(3.8) se muestran las partes de la plantilla de potenciales evocados.

desviacion: b4 single]
data: {1x34 cell}

Figura 3.8: Visualizacion de la estructura de las plantillas de potenciales evocados.

Las plantillas se han estructurado de la forma que se ha mostrado, para que puedan
ser facilmente comprensibles.
En la fase potenciales, el resultado que se muestra en pantalla son los momentos en

los cuales el programa ha detectado un potencial evocado.
Localizacion =
HombrePrimero:

HombreSegundo:

ClustersUsa

coeficientePears

Momen

Coeficiente: [0 0.7444 0.7677 0.7345]

Figura 3.9: Visualizacién de la localizaciéon

En la figura(3.9) se muestra la forma en que se presenta el resultado. Se muestra el
nombre de los archivos seleccionados, al igual que el momento en el cual el programa ha
considerado que hay un potencial evocado. Aparece el coeficiente obtenido por medio
de la ecuacion de Pearson y el coeficiente de Pearson que se ha usado como limite.
También se muestran el nimero de clusters usados.

Para entender mejor el significado del coeficiente de correlaciéon de Pearson, en la
figura(3.10) se muestran la comparacién entre una onda preseleccionada como potencial

evocado con una plantilla de potencial evocado y una plantilla de estado normal. El
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valor del coeficiente de Pearson entre la onda preseleccionada y la plantilla de potencial
evocado es 0.8289, mientras que el valor del coeficiente de correlacién de Pearson entre
la onda preseleccionada y la plantilla de estado normal es de 0.1571. Lo cual muestra
que la semejanza entre la onda preseleccionada y la plantilla de potencial evocado es

mucho mayor que la semejanza con el estado normal.

Comparacion entre onda preseleccionada y plantillas

Plantilla potencial evocado
Onda preseleccionada
Plantilla onda normal

] 100 200 300 400 500 600 700 BOOD 900 1000
Duracion[ms]

Figura 3.10: Comparacién de onda preseleccionada con plantillas.

La comparacion entre las muestras que aparecen en la figura(3.10) muestra que los
potenciales evocados no son totalmente iguales a la media de las muestras, que aparece
en la figura(3.5). Esto se debe a las variaciones dentro de las plantillas que tienen
los potenciales evocados. Pero en los distintos casos se pueden ver las caracteristicas
comunes, que son, valores de pico muy grandes y tras el pico, un cierto tiempo en el
cual el potencial es negativo. La forma, amplitud y latencia de los potenciales evocados
tiene gran cantidad de factores que son capaces de alterarlos. Estos factores son, la
edad del sujeto, el hecho de haber tomado cafeina, o cualquier otro de estimulante, o
alcohol. También se ha de considerar la dificultad de colocar los sensores siempre en el
mismo lugar.

Una de las ventajas de la libreria de EEGlab, es la capacidad que tiene de mostrar
la distribucién de los potenciales en el cerebro. De esta manera se puede ver de forma
mas sencilla las diferencias que hay entre los distintos sensores en el momento en que
aparece el potencial evocado.[23]

La figura(3.11) muestra la distribucién de la actividad electroencefalogréfica en el

momento del potencial evocado. En la imagen se puede ver como la el potencial que
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aparece en la posicion P7, posiciones en la figura(1.8).[24][21]

Latency of 26 seconds and 422 milliseconds

15

10

Figura 3.11: Vista de la distribucion de potenciales, cuando hay un potencial evocado.

Latency of B3 seconds and 320 milliseconds

15

0.5

-0.5

Figura 3.12: Vista de la distribucién de potenciales, cuando no hay un potencial
evocado.

Por el contrario, en la figura(3.12) se muestra la distribucién de la actividad
electroencefalografica cuando no hay un potencial evocado. Se puede ver como la
distribucién es méas homogénea. El valor de la actividad electroencefalogréfica se pueden
ver en la leyenda de la imagen, al igual que en la figura(3.11).

La diferencia entre las dos imégenes puede ser algo confusa si no se observa la

leyenda de cada una de ellas. En la figura(3.11) el color rojo tiene un valor de 15,
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mientras que en la figura(3.12), el rojo tiene un valor de 1.5, lo que significa que es
diez veces mas pequeno. De aqui se puede concluir que cuando aparece un potencial
evocado, la mayor parte de la actividad electroencefalografica es igual, excepto en el
sensor P7 y en el caso en el cual no aparece el potencial evocado, la distribuciéon de

actividad electroencefalografica es muy similar en todo el cerebro.
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Capitulo 4

Resultados

Como se ha indicado en la seccién(1.1), el objetivo principal de este proyecto es
detectar potenciales cognitivos. Por ello se hace un estudio sobre la capacidad que tiene
el programa desarrollado a la hora de detectar el instante en el cual se ha evocado el
potencial.

Durante la prueba pueden aparecer diversos potenciales evocados, pero que al no
haber sido evocados por los estimulos de interés se consideraran como errores. Estos
errores son debidos a las caracteristicas del dispositivo que se ha usado en este proyecto
y a la falta de conocimiento sobre el comportamiento del cerebro.[24]

Las pruebas que se han realizado exigen cierta concentracién por parte del sujeto
a quien se le realizan. Este factor es determinante en muchas ocasiones, como es en el
caso de las pruebas de los topos de colores. [24]

Por el contrario, en la prueba realizada con cartas, la similitud que hay entre varias
de ellas, por ejemplo, el 6 de espadas y el 7 de espadas, puede originar que aparezcan
potenciales evocados a lo largo de la prueba, originados por dicha equivocacién.|[24]

A la hora de obtener los resultados, como se ha visto en la seccién(3.4), el programa
proporciona los momentos en los cuales considera que ha aparecido un potencial
evocado. La falta de homogeneidad en los potenciales evocados hace imposible obtener
el resultado exacto a la hora de localizar los instantes en los cuales ha habido un
estimulo infrecuente.

Para averiguar si el programa realizado en este proyecto funciona correctamente,
los resultados del programa han sido separados en dos grupos. El primer grupo esta
formado por aquellos instantes en los cuales el programa detecta un potencial evocado
y este coincide con el estimulo evocador o infrecuente, a este grupo lo denominamos
potenciales evocados reales. El segundo grupo esta formado por aquellos momentos
en los cuales el programa ha detectado un potencial evocado, pero no se corresponde
ese instante con el instante en el cual aparece el estimulo infrecuente, a este grupo

lo denominamos potenciales evocados falsos. Se ha de hacer una aclaracién sobre
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los nombres. El nombre de potencial evocado falso no quiere decir que no tenga las
caracteristicas de los potenciales evocados, lo que ocurre es que no han sido evocados
por ningun estimulo concerniente a la prueba.

Estos resultados han sido calculados por medio de los estimadores estadisticos,
sensibilidad y especificidad. La sensibilidad nos indica la capacidad que tiene nuestro
método de detectar un potencial evocado y que este realmente lo sea, la formula se
muestra en la ecuacién(4.1). La especificidad nos indica la capacidad que tiene el
método utilizado para considerar como potencial evocado, casos en los que no ha
habido un evocador también llamado estimulo infrecuente, falsos potenciales evocados,
la formula se muestra en la ecuacién(4.2). Ademds de ello, calculamos el nimero de
potenciales evocados detectados y que son auténticos potenciales evocados, sobre el
nimero total de potenciales evocados que deberian haber sido detectados, la formula
se muestra en la ecuacién(4.3).[43]

La deteccion se define como media de potenciales evocados detectados en una
prueba. En la prueba de las cartas, al haber un tnico evocador, se puede definir como

la probabilidad de haber detectado el potencial evocado.

VP
bili =" 4.1
Sensibilidad VP FP (4.1)
e FP
Especi ficidad = VP L EP (4.2)
VP
Deteccion = ——— 4.3
eteccion = o7 — (4.3)

Donde V' P es el numero de verdaderos potenciales evocados que han sido detectados,
FP es el numero de falsos potenciales evocados que han sido detectados, aquellos
momentos detectados, en los cuales no habia un evocador y Totales es el nimero total
de evocadores, estimulos infrecuentes, que han aparecido en la prueba.

En la prueba realizada utilizando la baraja espanola, en la cual se debia detectar
la carta en la cual el sujeto esta pensando. Se ha realizado la bisqueda de potenciales
evocados con 3 clusters y con 4 clusters, como se muestra en la tabla(4.1), se muestra
como no hay diferencias aparentes en los resultados obtenidos. Se puede observar que en
ambos casos, tiene una probabilidad de detectar el instante en el que aparece la carta en
la que se esta pensando de un 50 %, esto significa que un 50 % de las ocasiones detecta
el instante en el cual aparece el evocador. También se puede ver como la sensibilidad
en ambos casos es de alrededor de un 21 %. Este valor es inferior al 50 %, el cual se
utiliza para determinar si una prueba es fiable o no.

En la prueba en la que se han utilizado topos de distinto color se han usado dos

modelos, en el primer modelo, denominado ”Topos 1”7, se han utilizado 5 evocadores y
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una duracion aproximada de la prueba de 3 minutos. El segundo modelo, denominado
"Topos 2”7, se han utilizado 2 evocadores y una duracién aproximada de la prueba de 1
minuto. En la tabla(4.1) se puede comprobar como hay una gran semejanza entre los
resultados de ambas pruebas.

Por ultimo, en la tabla(4.1) se muestran los resultados totales. Estos resultados se
asemejan mas a los resultados de las pruebas de los topos debido a que se han realizado
en total mas sesiones con el modelo de prueba de los topos que con el modelo de prueba

de las cartas.

’ Tipo de prueba \ Deteccion \ Sensibilidad \ Especificidad ‘

Carta (3 clusters) | 50 % 20.5 % 79.5%
Carta (4 clusters) | 50 % 21 % 79 %
Topos 1y 2 58 % 26.1% 73.9%
Topos 1 60 % 26.6 % 73.4%
Topos 2 54 % 24.56 % 75.44 %
Total 57 % 25.2 % 74.8%

Tabla 4.1: Tabla de resultados.

Como se puede ver en la tabla(4.1), la prueba de las cartas es la prueba que peor
funciona en el programa desarrollado. Una de las explicaciones que puede tener este
hecho es la ya mencionada confusion entre cartas, esto provoca potenciales evocados en
posiciones en las cuales no deberian aparecer, haciendo que la sensibilidad del método
no sea relevante. Por otro lado, estd la cuestion de los grupos formados por los clusters.
Aunque comparando tnicamente los datos obtenidos, no hay diferencias aparentes entre
usar 3 o 4 clusters en la prueba de las cartas.

Pero realizando el calculo de Chi cuadrado obtenemos que las pruebas tienen una
similitud del 99,9 %, indicando asi que aun teniendo diferentes sensibilidades, no son
significativamente independientes las pruebas entre si.[43]

En la prueba de las cartas, es interesante ver como se puede incrementar la
probabilidad de acertar la carta en la que se esta pensando. De esta manera se puede
ver de forma mas clara una de las utilidades que tiene este programa. Se muestran los
incrementos en la probabilidad de acertar en la tabla(4.2).

Se puede ver que utilizando estadistica descriptiva, se puede ver como el incremento
de la probabilidad de acertar es de més de 8 veces. Como se muestra en la tabla(4.2).
Considerando el caso general, todas las sesiones, se consigue un incremento en la
probabilidad de encontrar el estimulo infrecuente de hasta 8.97 veces.

Se debe aclarar la tabla(4.2), se define como probabilidad sin programa, a la

probabilidad que se tiene de averiguar en que instante ha aparecido el estimulo evocador
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’ Tipo de prueba \ Probabilidad sin programa \ Probabilidad con programa \ Incremento ‘

Carta (3 clusters) | 2.5% 20.5% 8.18
Carta (4 clusters) | 2.5% 21 % 8.4
Total 2.8% 25.2% 8.97

Tabla 4.2: Tabla de resultados 2.

sin usar el programa. En la prueba de las cartas seria la probabilidad que se tiene
de averiguar en que carta se estd pensando sin utilizar el programa. Se define como
probabilidad con programa a la probabilidad media que se tiene de averiguar en que
carta se esta pensando tras obtener los resultados. Esta probabilidad es igual a la
sensibilidad que aparece en la tabla(4.1). En este pardmetro se considera que hay una
probabilidad del 50 % de que entre los momentos en los cuales el programa ha detectado
la presencia de un potencial evocado y que la media de momentos considerados es de
2.5.

Como resultado final, en el caso de la prueba de las cartas, se tiene que el programa
es capaz de reducir la incertidumbre de 40 a 2.5, de media. Habiendo una probabilidad
del 50% de que la carta en la que se ha pensando se encuentre entre las cartas

detectadas.
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Capitulo 5

Conclusiones

Como se ha podido ver en el capitulo(4), la localizacion de los potenciales
evocados es complicada. Sabemos que con el dispositivo Emotiv Epoc+ se es capaz de
detectar potenciales evocados, pero es demasiado sensible a agentes exteriores, como
la colocacion de los sensores o la cantidad de pelo del sujeto.

Como vimos en el capitulo(2), con esta prueba se esta intentando usar a la hora de
detectar culpables de delitos, usdndose como el poligrafo. Pero viendo los resultados
obtenidos en nuestras pruebas, no se podria considerar como una prueba decisiva.

Uno de los mayores problemas que tiene el dispositivo Emotiv Epoc+ es la
localizacién de sus sensores. La mayor parte de ellos estdan colocados sobre los
l6bulos frontales, pero el motivo de esto no es tanto la captacion de las senales
electroencefalograficas, como la detecciéon de movimientos faciales. Recordaremos que
Emotiv ofrece un programa gratuito, en el cual el dispositivo capta los movimientos
faciales, como pestaneo, sonrisa, guinar los ojos. Estos movimientos, por desgracia,
ocasionaban el movimiento del sensor, generando la distorsiéon de las senales.

Otro de los motivos por los cuales Emotiv Epoc+ es un dispositivo con el cual es
complicado captar senales concretas de los electroencefalogramas, es la dificultad de
colocar el sensor en la misma posicién. Esto produce que el sensor P7 pueda estar
mas cerca, o mas lejos de la posicién Pz, que como se vio, es el lugar donde mejor se
distinguen los potenciales evocados cognitivos.

El aumento de la libreria de potenciales evocados permite que el programa detecte
mejor las posiciones en las cuales aparecen potenciales evocados. Y permite que se use
un coeficiente de correlacion de Pearson mayor, haciendo que estemos mas seguros del
buen funcionamiento del programa.

La eficiencia en el uso de los clusters depende en gran medida del nimero de ellos
que se usan. En este proyecto se han utilizado 3 clusters, como norma general.

Cuando se intentan medir pardmetros que no son objetivos, sino que son parametros

donde interviene el subconsciente, no se obtienen resultados claros o facilmente
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comprobables. En nuestro caso, se puede estar evocando un potencial de forma ajena a
la prueba. Esto hace que sea muy facil de enganiar al programa. Mirar hacia otro lado,
o pensar en otra cosa, hacen que no aparezcan potenciales evocados cuando deberian
aparecer.

En conclusion general, el uso de potenciales evocados para detectar estimulos
relevantes para el sujeto aun no es posible con dispositivos comerciales como Emotiv. El
desarrollo y mejora de dispositivos comerciales capaces de hacer electroencefalogramas
hara que pronto se sea capaz de detectar a la perfeccion los potenciales evocados.
El problema aparecera cuando el objetivo sea detectar estimulos que dependen de la

concentracion del sujeto, como en este experimento.
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Capitulo 6

Futuros proyectos

A partir de este proyecto, la Universidad de Zaragoza, puede comenzar a dar
aplicacion a este tipo de dispositivos. Emotiv ofrece la posibilidad de conseguir una
licencia con la cual se pueden obtener las senales en tiempo real. En este proyecto se
ha trabajado con datos previamente obtenidos.[20] De esta manera se podré procesar
las senales electroencefalograficas en tiempo real, consiguiendo asi unas aplicaciones
mas utiles.

Este tipo de dispositivos pueden ser de gran utilidad para los discapacitados. Ser
capaces de mover su silla de rueda sin tener que utilizar las manos, para poder dirigirla,
o poder expresar ideas, seria un gran avance.

Si se consideran los potenciales evocados, desde el punto de vista en el que han sido
utilizados en este proyecto, el ejemplo de mover una silla de ruedas seria tan sencillo
como disponer de una pequena pantalla en la que se mostraran las distintas direcciones
y ser capaces de detectar si el usuario de la silla de ruedas desea ir hacia delante o hacia
atras localizando cuando aparece el potencial evocado y cuando aparece en pantalla la
direccion a la que desea ir.

El ejemplo de ser capaces de expresar ideas ya esta siendo desarrollado. En el
capitulo(2) se ha comentado la prueba llamada ”Speller”. Esta prueba consiste en
ser capaz de deletrear una palabra, pero se puede conseguir transmitir una idea. Por
ejemplo, tengo hambre, simplemente evocando un potencial cuando aparece en pantalla
un plato de comida.

Como se puede ver, las posibilidades que tiene la utilizacion de este tipo de
dispositivos y la utilizacion de los potenciales evocados tiene dos variantes, con los
mismos fundamentos tedricos. Su utilizacion en pruebas policiales y su utilizaciéon a
nivel comercial. Siendo esta ultima opcién la que mas posibilidades tiene a la hora de
encontrar nuevas aplicaciones.

Como futuras mejoras en este tipo de pruebas, queda el desarrollo de nuevos

sistemas con los cuales se pueda discriminar el tipo de onda en funcién de factores
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como la atencién. De este modo se podra mejorar el programa desarrollado y asi se
obtendran unos resultados mas fiables.

El desarrollo de nuevas librerias de funciones de Matlab capaces de realizar clusters
en funcién de caracteristicas mas especificas de los potenciales evocados seria un
proyecto muy interesante y que podria mejorar mucho la eficiencia del procedimiento
de deteccion de potenciales evocados. Hemos podido ver como los potenciales evocados
poseen ciertas caracteristicas comunes, como pueden ser un pico con amplitud mucho
mayor a la media en el centro de la onda, esto es debido a la forma de guardar las
ondas del programa. También se aprecia como tras el pico, la onda adquiere valores
negativos, este hecho es muy importante a la hora de detectar potenciales evocados, y

de distinguir que tipo de potencial evocado es.
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Anexos A

Cdédigo de Matlab

A.1. Menu principal

% Autor: Juan Miguel Sewilla Blasco
% Funcion: Detectar potenciales evocados P300
% Descripcion : Este programa contiene un menu que da la posibilidad de

% anadir patrones de ondas de P300 a la libreria , detectar
% lugares en los que hay potenciales evocados P300, o ambas
% funciones.

% Preparar programa:

eeglab; %Necesario para que el programa funcione

clear all

close all

% Como escribir el nombre del archivo :

% nombre="Pruebas\ Oddball—i . csv’

canal=6; %7, canal que mejor detecta el P300
filtroAlto=0.5; %F'iltro paso alto a 0.5 Hz

filtroBajo=30; % iltro paso bajo a 30 Hz

grosor =128;

i=1;

while (i==1)

disp (' Elija._opcion: ")

disp ( '1—Anadir_patrones._de_potenciales _evocados )

disp ( '2—Buscar_potenciales._evocados’)

disp ( ’3—Buscar_y_anadir _patrones._de_.potenciales._evocados )
disp ( ’Cualquier .otro.numero.significa.cerrar._el__programa’)
opcion=input ( 'Escriba.el .numero:.")

switch opcion

case 1

% Leer nombre del archivo y posiciones del los evocadores
nombreEjemplo=input ( 'Escriba_el _.nombre_del _archivo:.")
momentoP300=input ( 'Indique _en_que_momento_hay_evocadores.de_P300: ")
% Leer datos obtenidos con Emotiv:

EEGejemplo=leerDatos (nombreEjemplo , filtroAlto , filtroBajo );
H.eer datos desde el archivo de Emotiv
EEGejemplo=normalizado (EEGejemplo ) ;
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% Sacar valores relevantes sobre el P300:
load(’'plantillas.mat’);

% El archivo plantillas contiene las "formas” de los P300
% obtenidos en las pruebas de testeo

plantillas=obtenerFormaP300 ( EEGejemplo , momentoP300, canal , plantillas ,...

...grosor)

save( 'plantillas’, ’plantillas’);
plantillas.potenciales
continuar=input(’volver._al_menu.(1=.Si,.0=.No):.")
if continuar==

i=1;

else

i1=0;

end

case 2

% Leer mombre del archivo

disp ( 'Para_obtener _un_resultado_mas_correcto ,_introduzca.el _nombre. ..

b

...de_dos_archivos._de_la_misma_prueba. ”)
nombrel=input ( ’Escriba.el _nombre_del_primer_archivo:.")
nombre2=input ( 'Escriba._el _nombre_del_segundo_archivo:.")

tiempo=input (’Escriba_el _tiempo_en_segundos , _que_se_puede_considerar ...

...como._margen: . )
coeficientePearson=input(’Escriba_el_valor.del_coeficiente ...

...de_Pearson:_")
numeroClusters=input(’Escriba_el _numero_de_cluster _que_se_quieren ...

.utilizar:.)
% Leer datos obtenidos desde Emotiv y que queremos analizar :
EEGl=leerDatos (nombrel , filtroAlto , filtroBajo );
% Leer datos desde el archivo de Emotiv
EEG2=leerDatos (nombre2 , filtroAlto , filtroBajo );
% Leer datos desde el archivo de Emotiv
% Localizar momento en que aparecen P300:
EEGl=normalizado (EEG1);
EEG2=normalizado (EEG2);
load (’plantillas .mat’);
% El archivo plantillas contiene las "formas” de los P300
Y%btenidos en las pruebas de testeo
EEGclusterizadol=clusterizar (EEGL, plantillas ,numeroClusters , ...

...canal , grosor);
EEGclusterizado2=clusterizar (EEG2, plantillas ,numeroClusters , ...

...canal ,grosor );
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Localizacionl=localizarMomentoP300cluster (EEG1, plantillas ,...

...canal ,coeficientePearson , grosor , EEGclusterizadol );
Hocaliza los posibles lugares en los que hay un P300
Localizacion2=localizarMomentoP300cluster (EEG2, plantillas ,...

...canal ,coeficientePearson , grosor , EEGclusterizado2 );
Localizacion=comparador (Localizacionl ,Localizacion2 ,tiempo , ...

...numeroClusters , coeficientePearson)

i=0;

case 3

% Leer nombre del archivo y posiciones del los evocadores
nombrel=input ( ’Escriba_el _nombre_del _primer_archivo:.")
nombre2=input ( 'Escriba_el _nombre_del_segundo._archivo:.")
tiempo=input (’Escriba_el_tiempo._en_segundos , ...

...que_se_puede_considerar._como_margen: . ")
coeficientePearson=input(’Escriba_el_valor_.del_coeficiente ...

...de_Pearson:.")
numeroClusters=input(’Escriba_el _numero_de_cluster._que...

.se_.quieren_utilizar:._.")
H.eer datos obtenidos desde Emotiv y que queremos analizar:
EEGI=leerDatos (nombrel , filtroAlto , filtroBajo );
Heer datos desde el archivo de Emotiv
EEG2=leerDatos (nombre2, filtroAlto , filtroBajo );
H.eer datos desde el archivo de Emotiv
EEGl=normalizado (EEG1);
EEG2=normalizado (EEG2);
load(’'plantillas.mat’);
% El archivo plantillas contiene las "formas” de los P300
Y%btenidos en las pruebas de testeo
% Localizar momento en que aparecen P300:
EEGclusterizadol=clusterizar (EEGL, plantillas ,numeroClusters , canal ,...

...grosor);
EEGeclusterizado2=clusterizar (EEG2, plantillas ,numeroClusters ,canal ...

... grosor);
Localizacionl=localizarMomentoP300cluster (EEG1, plantillas ,canal ,...

.coeficientePearson , grosor , EEGclusterizadol );
HWocaliza los posibles lugares en los que hay un P300

Localizacion2=localizarMomentoP300cluster (EEG2, plantillas ,canal ,...

.coeficientePearson , grosor , EEGclusterizado2 );
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Localizacion=comparador (Localizacionl ,Localizacion2 ,tiempo , ...

.numeroClusters , coeficientePearson );
Localizacion
i=0;
momentoP300=input ( 'Indique _en_que_momento_hay_evocadores.de_P300:.")
% Sacar wvalores relevantes sobre el P300:
plantillas=obtenerFormaP300 (EEG1, momentoP300, canal , plantillas , grosor );
plantillas=obtenerFormaP300 (EEG2, momentoP300, canal , plantillas , grosor);
save( 'plantillas’, ’plantillas ’);
plantillas.potenciales
otherwise
i=0;
end
end
close all

A.2. Leer datos

function [Output]=leerDatos (nombre, filtroAlto ,filtroBajo)
AN aa
Wodigo escrito por Hiran Ekanayake

Jhttp ://neurofeedback . visaduma. info/EmotivResearch. pdf
WIS
% import data from testbench csv file

tbdata = importdata(nombre);

eegdata = thbdata.data;

% remove unwanted fields

eegdata (:,17:39) = [];

eegdata (:,1:2) = [];

eegdata = eegdata =

% Prepare data in EEGLAB

eeglab

EEG = pop_importdata(’data’, eegdata, 'srate’ ;128);

% import data from MATLAB array

EEG = pop_chanevent (EEG, 15, edge’, leading’, ’edgelen’ 0);
% event channel

EEG = pop_chanedit (EEG, ’load’,{ ’emotiv.ced’ ’filetype’ ’autodetect’});
% channel locations

EEG = pop_eegfilt (EEG, filtroAlto, 0, [], [0]);
% highpass filtering at 1Hz
EEG = pop_eegfilt (EEG, 0, filtroBajo, [], [0]);

% low pass filtering at 20Hz
eeglab redraw

A A a

Winal codigo de Hiran FEkanayake

N A
EEG = eeg_checkset ( EEG );
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EEG = pop_runica (EEG, ’extended’,1,’interupt’,’on’);

% [ALLEEG FEG] = eeg_store (ALLEEG, FEG, CURRENTSET);

% eeglab redraw

% data = eeglab2fieldtrip ( EEG, ’preprocessing ', ’‘none’ );
EEG. setname=nombre;

EEG. filename=nombre;

eeglab redraw

Output=ktEG;

A.3. Normalizado

function [EEGnormalizado]=normalizado (EEG)
tmp = reshape (EEG. data, [size(EEG.data, 1) size(EEG.data, 2)...
...xsize (EEG. data, 3)

1)
tmp = zscore (tmp, 0, 2);
tmp = reshape (tmp, size (EEG.data));
EEGnormalizado=EEG;
EEGnormalizado.data = tmp;

A.4. Definir plantilla de P300

function [matrizForma]=obtenerFormaP300 (EEG, momentoP300 ...

... canal ,matrizForma , grosor)
for i=1:length (momentoP300)
[piconormalizado , posicion|=detectarPico (EEG, momentoP300(i) ,...

...grosor ,canal);
if (piconormalizado >=3)
matrizForma. potenciales. muestras=...

... matrizForma. potenciales . muestras+1;
matrizForma. potenciales.data{matrizForma. potenciales. muestras }...

..(1,:)=EEG.data(canal , posicion—grosor /2: posicion+grosor /2—1);

end

end

sum=zeros (1,128);

for j=1l:matrizForma.potenciales.muestras
sum=matrizForma. potenciales.data{j}(1,:)+sum;

end

matrizForma. potenciales . media=sum/ . ..

... matrizForma. potenciales . muestras;
for t=1:grosor
for y=1:matrizForma.potenciales.muestras
vecPot (y)=matrizForma. potenciales.data{y}(1,t);
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end
matrizForma. potenciales . desviacion (t)=std(vecPot);
end
sum=zeros (1,128);
for j=1:matrizForma.normal. muestras
sum=matrizForma.normal . data{j } (1,:)+sum;
end
matrizForma . normal . media=sum/matrizForma.normal . muestras ;

A.5. Detectar pico

function [pico,posicion]=detectarPico (EEG,1i,grosor ,canal);
pico=—1000;
posicion =0;
% if 128xi+I<=length (EEG. times)
for j=1l:grosor
if pico<EEG.data(canal ,128x%i+1+j)
pico=EEG. data (canal ;128 i+1+j );
posicion=128xi+1+j ;
else
pico=pico;
posicion=posicion;
end
end
% else
% posicion=length (EEG. times );
% pico=FEG. data (canal,length (EEG. times ) );
end

A.6. Clusterizar

function [EEGclusterizado]=clusterizar (EEG, plantillas ,numeroClusters ,. ..

...canal , grosor)

for i=1:fix (EEG.xmax—1)
[piconormalizado , posicion|=detectarPico (EEG, i, grosor ,canal);
PreCluster.data (:,i)=EEG. data(canal , posicion—grosor /2:posicion +...

...grosor/2—1);
PreCluster .momento(i)=posicion;
PreCluster.segundo (i)=fix (posicion /128);

end

PreCluster.data (:, fix (EEG.xmax))=

PreCluster . momento ( fix (EEG. xmax))

PreCluster.segundo ( fix (EEG. xmax))

plantillas.potenciales.media;

EEGclusterizado . data= kmeans(PreCluster.data’,numeroClusters);
EEGclusterizado . cluster=EEGclusterizado . data (1);
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EEGclusterizado . momentos=PreCluster . momento;
EEGclusterizado .segundo=PreCluster . segundo;

A.7. Localizar momento

function [Output]=localizarMomentoP300cluster (EEG, matrizForma , ...

...canal ,coeficiente ,grosor , EEGclusterizado)
j=0;
Localizacion . Nombre=EEG. filename ;
Localizacion . Momento(1)=0;
Localizacion . Coeficiente (1)=0;
for i=1:length(EEGclusterizado.momentos)—1
if EEGclusterizado.data(i)==EEGclusterizado.data (fix (EEG.xmax))
=it
matriz.data(j,:)=EEG. data(canal , EEGclusterizado . momentos(i) —...

...grosor /2: EEGclusterizado . momentos(i)+grosor /2—1);
matriz . momento(j)=EEGclusterizado . momentos(i)/128;
else
=35
end
end
factor=correlacionPearson (matriz ,matrizForma );
t=1;
for i=1:length(factor.data)
if factor.data(i)>=coeficiente
Localizacion .Momento(t)=fix (factor .momento(i));
Localizacion . Coeficiente (t)=factor.data(i);
t=t+1;
else
t=t ;

end
Output=Localizacion;

A.8. Correlacion de Pearson

function [factor|=correlacionPearson (matriz ,matrizForma)
for i=1:length(matriz.momento)
coeficientePotenciales=0;
coeficienteNormal=0;
for j=1l:matrizForma.potenciales.muestras
p=cov(matriz.data(i,:),matrizForma.potenciales.data{j}(:))/...

...sqrt(var(matriz.data(i,:))* var(matrizForma.potenciales.data{j}(:)));

correlacion=p(1,2);
if correlacion>coeficientePotenciales
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coeficientePotenciales=correlacion;
else
coeficientePotenciales=coeficientePotenciales;
end
end
for j=1:matrizForma.normal. muestras
p=cov(matriz.data(i,:) ,matrizForma.normal.data{j }(:))/...

...sqrt(var (matriz.data(i,:))* var(matrizForma.normal.data{j }(:)));
correlacion=abs(p(1,2));
if correlacion>coeficienteNormal
coeficienteNormal=correlacion
else
coeficienteNormal=coeficienteNormal ;
end
end
if coeficientePotenciales>coeficienteNormal
factor.data(i)=coeficientePotenciales;
factor .momento(i)=matriz.momento(1i);
end
end

A.9. Comparador

function [Localizacion]=comparador(Localizacionl ,Localizacion2 ,...

... tiempo ,numeroClusters , coeficientePearson)
t=0;
Localizacion . NombrePrimero=Localizacionl .Nombre;
Localizacion . NombreSegundo=Localizacion2 .Nombre;
Localizacion . ClustersUsados=numeroClusters;
Localizacion . coeficientePearson=coeficientePearson ;
for i=1:length(Localizacionl.Momento)

=1

v=1;

while (j<=length(Localizacion2.Momento))& (v==1)

if (Localizacionl.Momento(i)—tiempo<=Localizacion2.Momento(j))...

...&(Localizacionl .Momento(i)+tiempo>=Localizacion2 .Momento(]))

t=t+1;
Localizacion . Momento(t)=Localizacionl .Momento(1i);
Localizacion . Coeficiente (t)=Localizacionl . Coeficiente (i);
v=0;
j=1+1;

else
v=1;
=i +1;

end
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end

end
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Anexos B

Manual de uso

B.1. Emotiv

Toda la informacion ha sido sacada de Emotiv.[20]

B.1.1. Dispositivo

Emotiv Epoc+ es un dispositivo capaz de realizar electroencefalogramas, distribuido
por la compania Emotiv, https://www.emotiv.com/. En la figura(B.1) se muestra la

portada de la pagina web de Emotiv.

EMDT'V IWANTTO... ¥ PRODUCTS * THESCIENCE DEVELOPERS SUPPORT LIBRARY v STORE v = &

Open your mind to

BrainWear®

The most accurate, cost-effective whole
brain measuring technology on the market

Figura B.1: Pagina web de Emotiv[20]

Emotiv ofrece dos modelos de dispositivos, EMOTIV Insight con un precio de 299%
y Emotiv Epoc+ con un precio de 799%. La diferencia se encuentra en el nimero
de sensores que tiene cada uno de los dispositivos, Emotiv Insight tiene 5 sensores,
mientras que Emotiv Epoc+ posee 14 sensores.

Ambos dispositivos incluyen un liquido utilizado para hidratar los sensores, aparte

de ello viene incluido un cargador. La bateria del dispositivo dura alrededor de 12
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horas. La comunicaciéon entre el casco y el ordenador se hace por medio de bluetooth,
por medio de un usb que viene incluido con el dispositivo. En la figura(B.2) se muestran
los diferentes componentes del dispositivo Emotiv Epoc+. La frecuencia de muestreo
de Emotiv Epoc+ es de 128 Hz, esto permite que sea capaz de detectar todo el rango

de frecuencias de las ondas cerebrales, 0.1-30 Hz aproximadamente.

Figura B.2: Componentes Emotiv Epoc+[20]

La posicion de los sensores con respecto al sistema 10-20 se muestran en la

figura(B.4) y la colocacién en el craneo se muestra en la figura(B.3).

Figura B.3: Colocacién de Emotiv|20]

B.1.2. Software

Emotiv ofrece una gran variedad de softwares que pueden ser usados junto a sus
dispositivos. Muchos de los softwares que ofrece Emotiv son actualizados o sustituidos
por nuevas versiones. En la figura(B.5) se muestran los softwares que ofrece actualmente

Emotiv.
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Figura B.4: Colocacién de Emotiv con respecto al sistema 10-20[20]

EMO TV Ao+ MOCE + THESCENE DERSOPTES SIPRONT LmRArT  SIORE T B

Applications

= rifer praduces § Applcatioms 1 Shoveing al 3 resules

LA

#

Figura B.5: Softwares ofrecidos por Emotiv.[20]

Para poder adquirir los distintos softwares que ofrece Emotiv es necesario hacerse
una cuenta de usuario en su pagina web. La figura(B.6) muestra el lugar donde se

encuentra la opcion de hacerse una nueva cuenta de usuario.

Para adquirir uno de los softwares que proporciona Emotiv, se debe seleccionar
la opcion ”Store”, al apartado ”Applications” en la pagina web de Emotiv,
https://goo.gl/TNPCPp. Se debe seleccionar el producto que se desea comprar. En
este manual se pondra como ejemplo la adquisicion del software EmotivPro.

En la figura(B.7) se muestra la pantalla que aparece al seleccionar el software
EmotivPro. Para poder adquirirlo se debe seleccionar ”ADD TO CART”.

Cuando ya se ha seleccionado "ADD TO CART” se debe seleccionar el simbolo del

carro de la compra, arriba a la derecha, ahi apareceran los productos que se desean
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V2 IWANTTO... v PRODUCTS v THESCIENCE DEVELOPERS SUPPORT LIBRARY v STORE v ™ &

Open your mind to

BrainWear”

The most accurate, cost-effective whole
brain measuring technology on the market

Figura B.6: Hacerse una nueva cuenta.|20]

EMOTIV

IWANTTO... v PRODUCTS v THESCIENCE DEVELOPERS SUPPORT LIBRARY v STORE v+ W &

EmotivPRO

Annually (589 / month)

ADD TO CART

Figura B.7: Paso 1: adquisicién EmotivPro[20]

compra. En la figura(B.8) se muestra la pantalla que aparece al seleccionar el carro de la
compra. Para comprarlo se debe seleccionar la opcién ”PROCEED TO CHECKOUT”,
esta opcién nos llevara a la pantalla que se muestra en la figura(B.9), donde se deben
introducir los datos del usuario. La compra se hace por medio de tarjeta de crédito o
débito.

El software utilizado en este proyecto se llama PURE.EEG, pero ha sido actualizado
al software EmotivPRO, el cual tiene las mismas bases de funcionamiento pero con
la capacidad de insertar los instantes en los cuales se han introducido los estimulos,
https://www.emotiv.com/emotivpro/ es la pagina web del software EmotivPRO. El

precio de este software es 99%/mes. El manual de usuario se puede descargar desde
https://goo.gl/JuZFS6 .

El proceso para la adquisicion se debe ir a la opcidon ”Store”, al apartado

” Applications” en la pagina web de Emotiv, https://goo.gl/H63Ht7 .

Para comenzar una grabacién, se debe seleccionar el circulo rojo, como se muestra
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EMOTIV

I WANT TO... ¥ PRODUCTS v THESCIENCE DEVELOPERS SUPPORT LIBRARY ¥ STORE + ™ &
Product Price Quantity Total
—— EmotivPRO
x p ce 1 0+ $158.00/ month with a 15-day free tria
Cart Totals
. « e ey .
Figura B.8: Paso 2: adquisicién EmotivPro[20]
EMOTIV
I WANT TO... ¥ PRODUCTS v THESCIENCE DEVELOPERS SUPPORT LIBRARY v STORE * ® &
Billing Details Your order
First Name Product Total
e EMOotivPRO X 1
Period: $79.00/ month with a 15-day free trial
Last Name Monthly
pzlido send subtotal $0.00
Company Name Total $0.00

Recurring Totals

Email Address

Subtotal $79.00/ month

$79.00/ month

First renewal: September 25, 2017

Recurring Total

Phone

Country

S 2 == > | —

Pay securely using your credit card

Figura B.9: Paso 3: adquisicién EmotivPro[20]

en la figura(B.10). La figura(B.11) muestra el tiempo grabado. Para parar la grabacién

se debe seleccionar el cuadrado gris.

Figura B.10: Grabar una sesién[20]

Figura B.11: Finalizar grabacién.[20]

En la figura(B.12) se muestran las sesiones que han sido grabadas por el usuario.
Se pueden descargar desde Internet, para poder trabajar con ellas desde distintos
ordenadores.

Emotiv ofrece también un programa con el cual se es capaz de adquirir la senial en

tiempo real. Este software se llama SDK https://goo.gl/Todv{q.
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Figura B.12: Sesiones grabadas.[20]

B.2. EEGIlab

Toda la informacion ha sido sacada de EEGlab.[23]

EEGlab es wuna libreria gratuita de Matlab bajo licencia de GNU. En
el link https://scen.ucsd.edu/eeglab/index.php se puede encontrar el enlace
para descargar EEGlab y el tutorial para usar esta librerfa. En el enlace
http://neurofeedback.visaduma.info/EmotivResearch.pdf se indican los comandos que
se deben introducir en Matlab para que el archivo sea leido e interpretado por EEGlab.
El archivo que lee es .csv. En el link https://goo.gl/ykAi3Y se puede encontrar el
archivo llamado emotiv.ced, el cual sirve para indicar a EEGlab la disposicién de los
sensores de Emotiv Epoc+. En la figura(B.13) se muestra el ment principal de EEGlab.

EEGIlab posee la caracteristica de poder descargar nuevas librerias desde la propia
pantalla de EEGlab, mostrada en la figura(B.13), estas librerias estan destinadas a
distintas funciones, procesamiento de senales, eliminacién de artefactos, deteccién de
ondas, funciones especificas para realizar graficas de las senales, etc, etc.

En la figura(B.14) se muestra como se ve EEGlab cuando a leido un archivo. En
EEGIlab se muestran los datos principales del archivo.

Para obtener la grafica de las senales se debe seleccionar la opcién ”Plot” y entre
las opciones que se ofrecen, seleccionar la opcién ”Channel data(Scroll)”, esta opcién
muestra en pantalla las sefiales obtenidas de los 14 sensores. La figura(B.15) muestra
la senal de cada uno de los sensores. Si lo que se desea es ver la distribucién de la
actividad cerebral en un instante dado, se debe "clickar” con el botén derecho del

raton sobre la senal en el instante deseado, es necesario haber realizado el analisis
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File Edit Tools Plot Study ERPLAB ERPsets Datasets Help Automagic o

Figura B.13: Ment principal de EEGlab[23]

File Edit Tools Plot Study ERPLAB ERPsets  Datasets Help Automagic k]

Figura B.14: EEGlab con archivo.[23]

de componentes independientes (ICA) antes de realizar este procedimiento. En la
figura(B.16) se muestra la distribucion de la actividad cerebral en el momento indicado.

La estructura de los datos leidos por EEGlab se muestra en la figura(B.17).
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Figura B.15: Ondas mostradas en EEGlab.

Latency of B3 seconds and 320 milliseconds

15

0.5

-0.5

Figura B.16: Distribucién de actividad cerebral.
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EEG =

setname: "Pruebash\Oddball-1.csw'
filename: "Pruebas\Oddball-L.csw'
filepath: "'
subject: '
group: "'
conditiomn: '
sessiam: []
commemnts: "'
nibchamn: 14
trials: 1
pnts: 31103
srate: 128
=rmim: O
Himax: 242. 9922
times: [1xZ1104 double]
data: [14x31104 single]
icaact: [1
icawinw: [14x14 double]
icasphere: [14x14 double]
icaweights: [14x14 double]
icachansind: [L22 456 7891011 12 13 14]
chanlocs: [1x14 struct]
urchamlocs: []
chaninfo: [1x1 struct]
ref: "'commaomn'
event: [1x1 struct]
ureveaemnt: [1xl1 struct]
eventdescriptiomn: {™ " "}
epoch: []
epochdescription: {}
reject: [1xl struct]
stats: [1x1 struct]
specdata: []
specicaact: []
splimefile:
icasplimefile:
dipfit: []
history: '’
EEG.etc.eeglabwvers ='"14.1.1"; % this tracks which version of
EEGLAB is being used, you may ignore it
E...v
saved: "'no’
etc: [1x1 struct]

Figura B.17: Estructura de datos leidos por EEGlab.
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Anexos C

Pasos a seguir

En este apartado se va a explicar el procedimiento seguido para el desarrollo de
este proyecto. Se explicaran los pasos seguidos durante el proyecto, la explicacién del
uso de las distintas pruebas y el procedimiento seguido para detectar los potenciales

evocados.

C.1. Buasqueda de informacién

El primer paso para desarrollar un proyecto de este tipo es saber el tipo de funcién
cerebral que se quiere utilizar durante el proyecto, en este proyecto se han usado los
potenciales evocados generados en el area de la atencion. Las funciones de cada area

del cerebro fueron definidas por el Dr. Brodmann.[6]

Conociendo el area del cerebro donde se encuentran las neuronas encargadas de
ejecutar la funcion cerebral, que se quiere utilizar en el proyecto, se debe localizar
la posiciéon con respecto al sistema 10-20 en la cual se encuentra. El sistema 10-20
es el sistema internacional utilizado para definir la posicion de los sensores en los

electroencefalogramas.[6]

En este proyecto se han explotado los potenciales evocados cognitivos, estos
potenciales evocados son originados en la posicién Pz con respecto al sistema 10-20,
hay varios estudios, mencionados a lo largo de la memoria, en los cuales se explica
que el sensor de Emotiv Epoc+ que mejor capta este tipo de potenciales es el sensor
P7.[21][24] En la figura(B.4) se muestran los distintos sensores del dispositivo Emotiv

Epoc—+.[6]

El sensor P7 esta entre las areas de Brodmann, como se muestra en la figura(C.1).
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AREAS DE BRODMANN

[ Funciones ejecutivas
21 Funciones motoras
1 Somatosensorial
3 Atencion

1 Funciones visuales
1 Memoria

Regulacion emocional

3 Sonido
Fonoqqdiologos.wordpress.cam

Figura C.1: Areas de Brodmann[12]

C.2. Desarrollo de las pruebas

En la seccién(C.1) se ha explicado la importancia de la localizacién de los sensores
en funcién de las dreas de Brodmann. También se ha indicado a que el dispositivo
Emotiv Epoc+ no posee sensor en la posicién Pz con respecto al sistema 10-20, pero
se ha demostrado en varios proyectos, mencionados a lo largo de la memoria, que el
sensor que mejor captura la senal de los potenciales evocados cognitivos es el sensor
P7, pero este sensor se encuentra entre el drea de Brodmann 37 y 39, como se muestra
en la figura(C.1). Este sensor es capaz de recibir senales procedentes de un area cuya
funcién es la atencién y otra drea cuya funcién es la memoria.[24]

Conociendo esta primera limitaciéon del dispositivo Emotiv Epoc+ se debe realizar
una prueba que pueda ajustarse a esta limitacion, esto significa, poder utilizar la funcién
de la memoria dentro de la prueba.[24]

En este proyecto se han realizado dos modelos de prueba, la primera de ellas consiste
en un video en el cual aparecen todas las cartas de la baraja espanola, aparecen con
una frecuencia de 1 Hz. Esto hace posible que el sujeto pueda ver con claridad la

carta mostrada en la pantalla del ordenador, pero no tanto tiempo como para bajar
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la atencién. En esta prueba se estimula el drea de Brodmann de la atencién, al tener
que estar atenta a la carta que aparece en cada momento y el area de Brodmann de
la memoria, se debe recordar la carta en la cual se esta pensando. En esta prueba
la estimulacién del area de la memoria es menor que la estimulacién del drea de la
atencion.[37][16][38][35][1][24][34][2][35][36]

El segundo modelo de prueba consiste en contar el nimero de veces que aparece
un tipo de estimulo. En esta prueba aparecen dos tipos de estimulos, uno frecuente
y uno infrecuente. En la prueba aparecen en pantalla un circulo de color verde o
morado, en la figura(C.2) se muestra el estimulo frecuente, aparece un 97 % de las
veces. En la figura(C.3) se muestra el estimulo infrecuente, aparece con un 3% de las
veces.[37][16][38][35][1][24][34][2][35][36]

Figura C.2: Estimulo visual verde[39]

Figura C.3: Estimulo visual morado|[39]

El estimulo infrecuente es el estimulo que evoca la aparicion de potenciales evocados
P300. Ademas de estar atento a la aparicién del estimulo evocador, se pide al usuario
que cuente el nimero de veces que ha aparecido a lo largo de la prueba. El hecho de
contar el nimero de veces que aparece un evocador tiene dos funciones, la primera
de ellas es asegurarnos en cuantos evocadores ha estado atento y con ello, cuantos ha
podido distinguir. El segundo objetivo de contar el niimero de evocadores hace que el
area de la memoria este en funcionamiento, al contar, la memoria se actualiza, haciendo

que el potencial evocado sea mas facil de detectar.[37][16][38][35][1][24][34][2][35][36]
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C.3. Diseno de un programa de deteccion de
potenciales evocados

En los dtltimos anos se han desarrollado distintos métodos de deteccion de
potenciales evocados. La mayoria de los métodos se basan en métodos estadisticos,
entre los que destacan los usos de ANOVAs y el uso de clusters, estos ultimos utilizados
en este proyecto. También se usan correlaciones para comparar posibles potenciales
evocados con plantillas de potenciales evocados.[41]

El método que se utiliza para detectar potenciales evocados depende en gran parte
del programa que se utiliza en el proyecto. En este proyecto se ha utilizado el software
Matlab con la librerfa EEGlab, en la seccién(B.2) se explica en mas detalle la libreria
EEGIlab y donde descargarlo.

Otro programa utilizado en el procesamiento de electroencefalogramas es el software
Cartool, que se puede descargar desde https://goo.gl/NDEulb .[41]

Los métodos que se estan utilizando en la actualidad para detectar potenciales

evocados son:
— Clusters.
— ANOVA.
— Correlacion.

En la utilizacién de clusters hay diferentes factores que influyen, entre ellos se
destacan el numero de clusters que se realizan, se recomienda el uso de 3 clusters, se
considera que 3 es un nimero aceptable ya que no son ni muy pocos, 2, ni muchos.[41]

El segundo factor que influye es la forma de separar la senal en clusters. En este
proyecto se han creado matrices con una 128 filas, esto significa que en cada columna
hay un segundo de datos, la frecuencia de muestreo de Emotiv Epoc+ son 128 Hz. Pero
si se deciden hacer columnas con 64 filas, medio segundo de datos, se puede proceder
a buscar secuencias de datos y no un solo cluster.

El método utilizado en este proyecto ha sido crear matrices con 128 filas, esto
equivale a 1 segundo de informacién y tantas columnas como segundos hay en la prueba,
a esto se le ha anadido una columna extra en la cual se encuentra la plantilla del
potencial evocado medio. Se ha convertido la senal en una matriz debido a que se ha
utilizado la funcion kmeans de Matlab.

Ejemplo:

— Se han hecho matrices con 128 filas, esto hace que cree clusters en los cuales

agrupa momentos con duraciéon 1 segundo, como las plantillas de nuestro
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programa tienen duracion 1 segundo, se han de buscar aquellos momentos que

estén en el mismo cluster que nuestra plantilla de potencial evocado.

— Se han hecho matrices con 64 filas, esto hace que cree clusters en los cuales agrupa
momentos con duraciéon medio segundo. En este caso se debe buscar la secuencia
que e compone nuestro ejemplo de potencial evocado, un ejemplo seria 1 2, esto
significa que se han de buscar los momentos e los cuales aparece esa secuencia de

clusters. pudiendo aumentar el tamano de la serie.

C.4. Ejemplo

En esta seccion se va a explicar un ejemplo de procedimiento que se ha de seguir
para realizar una prueba. Se va a explicar el procedimiento para localizar la posicion
de los estimulos evocadores por medio de la deteccién de potenciales evocados.

Este proceso consta de dos fases, la primera fase consiste en la adquisicién de
plantillas de potenciales evocados. Las plantillas se definen a partir de potenciales
evocados auténticos, ademas de definir estas plantillas, se define una plantilla a partir

de la media de las plantillas.

C.4.1. Definicion de plantillas

1) Realizacién de una prueba en la cual haya estimulos que sean capaces de evocar

potenciales evocados.

2) Con la sesién ya grabada se procede a leerla en Matlab. La lectura del los datos se
hace utilizando la libreria de Matlab EEGlab. Para organizar los datos se utiliza el

archivo ”emotiv.ced” en la subsecciéon(B.2) se explica como obtenerlo.

3) Se debe indicar en que momentos ha habido estimulos capaces de evocar un potencial

evocado.

4) La senal es filtrada con un filtro paso alto a 0.5 Hz y un filtro paso bajo a 30 Hz. Se
usa este tipo de filtrado para eliminar todas aquellas frecuencias que no estan en el

rango de frecuencias de las ondas encefalogréficas, se explica en la seccién(1.2).

5) Se procede a normalizar la senal. Normalizar la senal consiste en centrar la
senial en 0 y obtener una senal con desviacién tipica 1. De este modo se pueden
comparar sesiones de distintos usuarios y distintas sesiones. Ademas, se puede usar

la estadistica para facilitar los calculos.
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6) Se busca en los momentos en los cuales se ha indicado que ha habido un estimulo
evocador la amplitud de la onda. Para ello se centran las ondas en el pico mas
alto de la onda. Se seleccionan como potenciales evocados solo aquellas ondas con
una amplitud mayor a 3, al haber sido normalizado, el 99,7 % de los datos tienen
un valor menor que 3. Por ello se escogen esos valores, asi se utilizan para definir
como nuevas plantillas aquellos momentos en los cuales habia un evocador y tienen
una amplitud mucho mayor que el resto de valores. En la figura(C.4) se muestra la
plantilla del potencial evocado medio, obtenido calculando la media de las plantillas

de potenciales evocados definidos hasta el momento.

Plantilla de potencial evocado

Walor normalizado
—

0 100 200 300 400 500 600 700 OO SO0 1000
Duracion [ms]

Figura C.4: Plantilla de potencial

C.4.2. Localizacién de potenciales evocados
1) Se realizan dos sesiones con la misma prueba.
2) Se leen los datos utilizando Matlab y la librerfa EEGlab.

3) Se puede indicar la falta de sincronizacién entre las dos sesiones. Esto hace posible
que si ha habido una falta de siscronizacion de 1 segundo, pueda considerarse en el

programa.

4) Se debe indicar el limite del coeficiente de correlacién de Pearson a partir del cual

se considera potencial evocado.
5) Se indica el nimero de clusters en los cuales se desea dividir la senal.
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6)

10)

11)

Las senales son filtradas con un filtro paso alto a 0.5 Hz y un filtro paso bajo a 30
Hz. Se usa este tipo de filtrado para eliminar todas aquellas frecuencias que no estan

en el rango de frecuencias de las ondas encefalograficas, se explica en la seccién(1.2).

Se procede a normalizar las senales. Normalizar las senales consiste en centrar las
senales en 0 y obtener senales con desviacién tipica 1. De este modo se pueden
comparar sesiones de distintos usuarios y distintas sesiones. Ademas, se puede usar
la estadistica para facilitar los calculos. En la figura(C.5) se muestran los pasos de

filtrado y normalizado, 3 primeras cuadriculas.

Habiendo sido filtradas y normalizadas las senales se procede a realizar los clusters.
Para ello se cogen segundo por segundo en ambas senales. Cada segundo es centrado
en el pico de mayor amplitud, para asi asemejarlo mas a las plantillas de potenciales
evocados. Cada segundo, ya centrado, se convierte en una columna de la matriz que
contiene todos los instantes de la sesién. A esta matriz se le anade una columna

mas en la cual se encuentra la plantilla de los potenciales evocados medios.

Tras realizar el cluster se seleccionan aquellos instantes que se encuentran
el mismo grupo que la plantilla de potencial evocado, estas ondas poseen
caracteristicas parecidas a los potenciales evocados. Estas ondas se consideran ondas
preseleccionadas. En la figura(C.5), cuarta imagen, se muestra un ejemplo de la

divisiéon de los segundos.

Comparacién por medio del coeficiente de correlacién de Pearson. En esta fase se
procede a comparar utilizando el coeficiente de correlacién de Pearson las ondas
preseleccionadas con las plantillas de potenciales evocados obtenidos en la primera
parte del programa y también con plantillas de momentos en los cuales no hubo un
potencial evocado. En la figura(C.6) se muestra la comparacion entre las plantillas y
las ondas preseleccionadas. Solo seran seleccionadas aquellas ondas cuyo coeficiente
de correlacion de Pearson con la plantilla del potencial evocado sea mayor que con
la plantilla de estado normal, ademas, debe ser el coeficiente de correlacién mayor

al limite indicado a comienzo del programa.

Comparacion entre las dos sesiones. En la figura(C.7) se muestra un ejemplo de
la comparacién que se hace. Solo se seleccionan como momentos en los cuales ha
aparecido un autentico potencial evocado debido a la prueba a aquellos momentos en
los cuales ha aparecido un potencial evocado en el mismo instante en las dos pruebas,
teniendo en cuenta la posibilidad del desfase debido a la falta de sincronizacién que

ha sido indicada a comienzo del programa. Esto se hace para eliminar potenciales
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evocados originados por factores externos a la prueba. Trae consigo la posibilidad
de eliminar momentos en los cuales habia habido un potencial evocado pero debido

a la falta de atencion en una de las sesiones no se considera como tal.
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Figura C.5: Pasos seguidos

Comparacion entre onda preseleccionada y plantillas

Plantilla potencial evocado
Onda preseleccionada
Plantilla onda normal

s 1 1 1 1 1 1 1 1 1

1] 100 200 300 400 500 600 700 BOOD 900 1000
Duracion[ms]

Figura C.6: Comparacién de onda preseleccionada con plantillas.
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Figura C.7: Comparacién de senales de distintas sesiones.
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